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Gewährleistung und Haftung 
 

Hinweis Die Anwendungsbeispiele sind unverbindlich und erheben keinen Anspruch auf 
Vollständigkeit hinsichtlich Konfiguration und Ausstattung sowie jeglicher Eventualitäten. 
Die Anwendungsbeispiele stellen keine kundenspezifischen Lösungen dar, sondern sollen 
lediglich Hilfestellung bieten bei typischen Aufgabenstellungen. Sie sind für den 
sachgemäßen Betrieb der beschriebenen Produkte selbst verantwortlich. Diese 
Anwendungsbeispiele entheben Sie nicht der Verpflichtung zu sicherem Umgang bei 
Anwendung, Installation, Betrieb und Wartung. Durch Nutzung dieser 
Anwendungsbeispiele erkennen Sie an, dass wir über die beschriebene Haftungsregelung 
hinaus nicht für etwaige Schäden haftbar gemacht werden können. Wir behalten uns das 
Recht vor, Änderungen an diesen Anwendungsbeispiele jederzeit ohne Ankündigung 
durchzuführen. Bei Abweichungen zwischen den Vorschlägen in diesem 
Anwendungsbeispiel und anderen Siemens Publikationen, wie z. B. Katalogen, hat der 
Inhalt der anderen Dokumentation Vorrang. 

Für die in diesem Dokument enthaltenen Informationen übernehmen wir keine 
Gewähr. 
Unsere Haftung, gleich aus welchem Rechtsgrund, für durch die Verwendung der 
in diesem Applikationsbeispiel beschriebenen Beispiele, Hinweise, Programme, 
Projektierungs- und Leistungsdaten usw. verursachte Schäden ist ausgeschlossen, 
soweit nicht z. B. nach dem Produkthaftungsgesetz in Fällen des Vorsatzes, der 
groben Fahrlässigkeit, wegen der Verletzung des Lebens, des Körpers oder der 
Gesundheit, wegen einer Übernahme der Garantie für die Beschaffenheit einer 
Sache, wegen des arglistigen Verschweigens eines Mangels oder wegen 
Verletzung wesentlicher Vertragspflichten zwingend gehaftet wird. Der Schadens-
ersatz wegen Verletzung wesentlicher Vertragspflichten ist jedoch auf den 
vertragstypischen, vorhersehbaren Schaden begrenzt, soweit nicht Vorsatz oder 
grobe Fahrlässigkeit vorliegt oder wegen der Verletzung des Lebens, des Körpers 
oder der Gesundheit zwingend gehaftet wird. Eine Änderung der Beweislast zu 
Ihrem Nachteil ist hiermit nicht verbunden. 
Weitergabe oder Vervielfältigung dieser Anwendungsbeispiele oder Auszüge 
daraus sind nicht gestattet, soweit nicht ausdrücklich von der Siemens AG 
zugestanden. 

 

Security-
hinweise 

Siemens bietet Produkte und Lösungen mit Industrial Security-Funktionen an, die den 
sicheren Betrieb von Anlagen, Systemen, Maschinen und Netzwerken unterstützen. 

Um Anlagen, Systeme, Maschinen und Netzwerke gegen Cyber-Bedrohungen zu sichern, 
ist es erforderlich, ein ganzheitliches Industrial Security-Konzept zu implementieren (und 
kontinuierlich aufrechtzuerhalten), das dem aktuellen Stand der Technik entspricht. Die 
Produkte und Lösungen von Siemens formen nur einen Bestandteil eines solchen 
Konzepts. 

Der Kunde ist dafür verantwortlich, unbefugten Zugriff auf seine Anlagen, Systeme, 
Maschinen und Netzwerke zu verhindern. Systeme, Maschinen und Komponenten sollten 
nur mit dem Unternehmensnetzwerk oder dem Internet verbunden werden, wenn und 
soweit dies notwendig ist und entsprechende Schutzmaßnahmen (z.B. Nutzung von 
Firewalls und Netzwerksegmentierung) ergriffen wurden.  

Zusätzlich sollten die Empfehlungen von Siemens zu entsprechenden Schutzmaßnahmen 
beachtet werden. Weiterführende Informationen über Industrial Security finden Sie unter 
http://www.siemens.com/industrialsecurity.  

Die Produkte und Lösungen von Siemens werden ständig weiterentwickelt, um sie noch 
sicherer zu machen. Siemens empfiehlt ausdrücklich, Aktualisierungen durchzuführen, 
sobald die entsprechenden Updates zur Verfügung stehen und immer nur die aktuellen 
Produktversionen zu verwenden. Die Verwendung veralteter oder nicht mehr unterstützter 
Versionen kann das Risiko von Cyber-Bedrohungen erhöhen.  

Um stets über Produkt-Updates informiert zu sein, abonnieren Sie den Siemens Industrial 
Security RSS Feed unter http://www.siemens.com/industrialsecurity. 

http://www.siemens.com/industrialsecurity
http://www.siemens.com/industrialsecurity
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1 Aufgabe 

Einführung 

Sie haben ein TIA Portal-Projekt in einer Projektsprache erstellt und möchten 
dieses nun in mehrere Zielsprachen übersetzen. Um Projekttexte in andere 
Sprachen zu übersetzen, gibt es mehrere Möglichkeiten. Einerseits können Sie die 
einzelnen Projekttexte im TIA Portal händisch anpassen oder die Projekttexte von 
einem externen Dienstleister übersetzen lassen. Dieses Anwendungsbeispiel zeigt 
Ihnen andererseits, wie Sie mit dem TIA Translation Tool V2.x schnell, unabhängig 
und effizient Projekttexte übersetzen können. 

 

Abbildung 1-1 
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2 Lösung 
 
Mit dem TIA Translation Tool V2 übersetzen Sie Ihre Projekttexte automatisch mit 
Hilfe von Wörterbüchern. Durch immer umfassendere Wörterbücher erreichen Sie 
mit der Zeit einen hohen automatischen Übersetzungsgrad. 

Vorteile 

Das TIA Translation Tool V2 bietet Ihnen folgende Vorteile: 

 Im Vergleich zum TIA Translation Tool V1 vereinfachte Oberfläche. 

 Effektive Übersetzung durch umfassende Wörterbücher. 

 Zeit- und Kostenersparnis durch automatische Übersetzung. 

Abgrenzung 

Dieses Anwendungsbeispiel enthält keine Beschreibung von: 

 TIA Portal (Projektierung) 

Grundlegende Kenntnisse über dieses Thema werden vorausgesetzt. 

Voraussetzungen 

 Installation des TIA Translation Tools V2 

 Exportierte TIA Portal-Projekttexte 

 

Hinweis Sie benötigen für dieses Anwendungsbeispiel eine Projekttextdatei, die Sie im 
TIA Portal aus Ihrem Projekt exportieren. 

 



2 Lösung 

 

TIA Translation Tool V2 
Beitrags-ID: 109475709,    V1.0,    03/2017   6 
 


 S

ie
m

e
n

s
 A

G
 2

0
1

7
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

2.1 Hard- und Software-Komponenten 

Gültigkeit 

Dieses Anwendungsbeispiel ist gültig für folgende Software-Versionen: 

 TIA Portal ab V14 

 TIA Translation Tool V2 

Verwendete Komponenten 

Das Anwendungsbeispiel wurde mit den nachfolgenden Komponenten erstellt: 

Software-Komponenten 

Tabelle 2-1 

Komponente Anz. Artikelnummer Hinweis 

TIA Translation Tool V2 1 -- Den Download finden Sie Im 
Beitrag mit der ID: 109475387 

TIA Portal ab V14  1 6AV210.-….3-0 
6AV210.-….4-0 

-- 

 

2.2 Beispieldateien und Projekte  

Die folgende Tabelle enthält alle Dateien und Projekte, die in diesem 
Anwendungsbeispiel verwendet werden. 

Tabelle 2-2 

Komponente Hinweis 

109475709_TIA_TranslationTool_V2_DOC_de.pdf Dieses Dokument. 
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3 Funktionsweise 

Gesamtübersicht 

Die folgende Abbildung zeigt die grundsätzliche Funktionsweise der Übersetzung 
mit dem TIA Translation Tool. 

 

Abbildung 3-1 Übersicht 

TIA Portal

Projekttexte

Import ins TIA 

Translation Tool

Übersetzte 

Projekttexte

Übersetzung Export 

 

 

Das TIA Translation Tool übersetzt Ihre Projekttexte mithilfe der hinterlegten 
Wörterbücher. Je häufiger Sie das TIA Translation Tool nutzen, desto umfassender 
werden die vorhandenen Wörterbücher. Da Sie jeden Begriff nur einmal händisch 
übersetzen und anschließend in ein Wörterbuch speichern, müssen Sie in Zukunft 
immer weniger händisch übersetzen.  

Das Anwendungsbeispiel zeigt, wie Sie das TIA Translation Tool bedienen und 
welche Schritte nötig sind, um Projekttexte aus dem TIA Portal zu übersetzen.  

Allgemeine Vorgehensweise 

1. Export der Projekttexte aus dem TIA Portal. 

2. Import der Projekttexte in ein TIA Translation Tool-Projekt. 

3. Übersetzung im TIA Translation Tool. 

4. Export der übersetzten Projekttexte aus dem TIA Translation Tool. 

5. Import der übersetzten Projekttexte in das TIA Portal. 

 

Im Kapitel 5 wird diese Vorgehensweise detailliert beschrieben. 
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4 Installation und Inbetriebnahme 

Installation der Software  

Um das TIA Translation Tool zu installieren, gehen Sie wie folgt vor: 

1. Laden Sie die Datei "TIATranslationTool_V2.x_setup.exe" von der 
Beitragsseite dieses Anwendungsbeispiels herunter: 
https://support.industry.siemens.com/cs/ww/de/view/109475709 

 

Hinweis Aussagen zur Kompatibilität des TIA Translation Tools finden Sie im 
Kompatibilitäts-Tool unter der Beitrags-ID: 64847781 
http://www.siemens.de/kompatool 

 

2. Entpacken Sie die ZIP-Datei.  

3. Klicken Sie auf die Datei "TIATranslationTool_V2.0_setup.exe", um die 
Installation zu starten. 

4. Folgen Sie den Anweisungen des Installations-Wizard und klicken Sie im 
letzten Schritt auf die Schaltfläche "Install". 

 

Hinweis Bei der Installation wird keine Verknüpfung auf dem Desktop angelegt. Für eine 
Desktop-Verknüpfung öffnen Sie den Installationspfad. Erstellen Sie eine 
Verknüpfung der Datei "TIA.Translation.Tool.exe" auf Ihrem Desktop. 

Der Standard-Installationspfad ist: "C:\Programme (x86)\Siemens AG\TIA 
Translation Tool" ("C:\Program Files (x86)\Siemens AG\TIA Translation Tool"). 

 

https://support.industry.siemens.com/cs/ww/de/view/109475709
http://www.siemens.de/kompatool
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5 Bedienung des TIA Translation Tools 

5.1 Übersicht  

Übersicht und Beschreibung der Oberfläche  

Abbildung 5-1: Übersicht der Symbolschaltflächen 

 
 

Schaltflächen zum Ein- und Ausblenden der Spalten 

 Schaltflächen zum Filtern der Einträge  
 

Schaltflächen "Rückgängig" und "Wiederholen" 
 

Schaltfläche "Ansicht aktualisieren" 
 

Schaltfläche "Kopiere ins Wörterbuch" 
 

Schaltfläche "Analysiere" 
 

Schaltflächen "Import" und "Export" (für die Projekttextdateien) 

 Taskcards der Spracheinstellungen und Eigenschaften (Wörterbücher) 

 

Hinweis Wenn Sie das Tool starten und Sie kein Projekt geöffnet haben, werden die oben 
erklärten Symbole nicht angezeigt. Erstellen oder öffnen Sie ein Projekt, um die 
oben gezeigte Ansicht zu erhalten.  

Die Oberflächensprache können Sie mit der Auswahlbox (9) ändern. 

 

 

1 2 3 4 5 6 7 

1 

2 

3 

4 

5 

6 

7 

8 

8 

9 



5 Bedienung des TIA Translation Tools 

 

TIA Translation Tool V2 
Beitrags-ID: 109475709,    V1.0,    03/2017   10 
 


 S

ie
m

e
n

s
 A

G
 2

0
1

7
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

Abbildung 5-2 

 
 

Schaltflächen zum Öffnen von Projekten und Wörterbüchern 

 Schaltflächen zum Speichern der Projekte und Wörterbücher 
 

Optionskästchen "Begriff gesperrt" 
 

Optionskästchen "Referenz benutzen" 

 

2 

3 

4 

1 

1 
2 

3 4 
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5.2 TIA Portal-Projekttexte exportieren 

Um TIA Portal-Projekttexte mit dem TIA Translation Tool übersetzen zu können, 
müssen Sie diese zunächst aus Ihrem TIA Portal-Projekt exportieren.  

1. Öffnen Sie Ihr TIA Portal-Projekt. 

2. Navigieren Sie im TIA Portal in der Projektnavigation zu 
"Sprachen & Ressourcen > Projekttexte" ("Languages & ressources > 
Project texts"), um die Projekttexte anzuzeigen. 

Abbildung 5-3 

 

3. Um die Projekttexte zu exportieren, klicken Sie auf "Werkzeuge > Projekttexte 
exportieren" ("Tools > Export project texts").  

Der folgende Dialog wird geöffnet. 

Abbildung 5-4 

 

 2 

 3 

 1 
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Wählen Sie die gewünschte Quellsprache und Zielsprache (1).  

In diesem Anwendungsbeispiel wird nur die Quellsprache English (United 
States) exportiert. Die Zielsprache wird später im TIA Translation Tool 
festgelegt. 

Wählen Sie aus, welche Textarten Sie exportieren möchten (2). Geben Sie 
einen Dateinamen und einen Speicherpfad an (3). 

Klicken Sie auf die Schaltfläche "Exportieren" ("Export"). 

 

Hinweis Wenn bereits im TIA Portal projektierte Zielsprachen in das Translation Tool 
importiert werden sollen, so geht dies immer in Paaren von "Quellsprache" und 
einer der "Zielsprachen". Sie benötigen in diesem Fall so viele Export-Dateien, 
wie sie Zielsprachen exportieren wollen. 

Beim Anlegen einer Sprache im TIA Portal werden bereits manche 
Projekttextfelder vorausgefüllt, z. B. werden die Projekttextfelder mit einem 
Platzhalter versehen. Diese Platzhalter werden im Translation Tool als bereits 
übersetzt gezählt. 

 

5.3 Ein neues TIA Translation Tool-Projekt anlegen 

1. Um das TIA Translation Tool zu starten, doppelklicken Sie auf die Datei 
"TIA.Translation.Tool.exe". 
Die Datei finden Sie im Installationspfad. Der Standard-Installationspfad ist: 
"C:\Programme (x86)\Siemens AG\TIA Translation Tool"  

Das TIA Translation Tool V2 wird geöffnet. 

2. Legen Sie ein neues Projekt an. Klicken Sie hierzu im Menü auf "Datei > Neu > 
Projekt" ("File > New > Project"). 

3. Geben Sie anschließend im Speicherdialog einen Dateinamen ein und klicken 
Sie auf "Speichern" ("Save"). TIA Translation Tool-Projekte werden mit der 
Dateiendung ".ttp" gespeichert. 
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5.4 Projekttexte in das Translation Tool importieren 

1. Klicken Sie auf die Symbolschaltfläche "Projekt importieren". 

Abbildung 5-5 

 

2. Wählen Sie im Dialogfenster die exportierte Projekt-Datei aus. 

3. Klicken Sie auf die Schaltfläche "Öffnen". 

Hinweis Im TIA Translation Tool wird in der Titelzeile des Projekts die Export-Format 
Version angezeigt. 

 

 

5.5 TIA Translation Tool V1 Projekte hochrüsten 

Wenn Sie TIA Translation Tool V1 Projekte mit Projekttexten aus TIA Portal V13 
ins TIA Portal V14 importieren möchten, gehen Sie folgendermaßen vor: 

1. Erstellen Sie im TIA Translation Tool V1-Projekt ein neues Wörterbuch, z.B. 
"V14Import". 

2. Speichern Sie alle Projekttexte in dieses Wörterbuch. 

3. Erstellen Sie ein neues TIA Translation Tool V2 Projekt. 

4. Fügen Sie das Wörterbuch "V14Import" ein. 

5. Importieren Sie die TIA Portal V14 Projekttexte in das TIA Translation Tool V2 

6. Übersetzen Sie alles mit dem Wörterbuch "V14Import". 

 

Hinweis Sie können aufgrund der unterschiedlichen Export-Formate die Projekttexte nicht 
von "V13" zu "V14" konvertieren.  

 

 

5.6 Neue Sprachen anlegen 

Sprachen aus dem TIA Portal-Projekt importieren 

Wenn im TIA Portal bereits große Teile der Projekttexte in die Zielsprache 
übersetzt worden sind, dann importieren Sie zusätzlich zur Quellsprach auch die  
Zielsprachen ins TIA Translation Tool. Für den Import ist pro Zielsprache jeweils 
eine ".xlsx"-Export-Datei aus dem TIA Portal erforderlich. 
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Sprachen im Tool anlegen  

Sie können Zielsprachen im TIA Translation Tool über die Taskcard "Languages" 
neu anlegen. Wenn Sie die übersetzten Projekttexte in das TIA Portal importieren, 
werden diese Zielsprachen automatisch im TIA Portal angelegt. Es sind keine 
weiteren Einstellungen im TIA Portal notwendig. 

 

5.7 Projekttexte übersetzen 

Vorbereitung 

Stellen Sie über die Taskcard "Sprachen" ("Languages") die Quellsprache und die 
Zielsprache(n) ein. 

Hinweis Sie können Ihre bisherigen Wörterbücher des TIA Translation Tools auch in der 
Version 2 weiterverwenden. 

Verwendete Wörterbücher 

In der Taskcard "Einstellungen" ("Settings") (1) können Sie über die Schaltfläche 
"+" (2) die Wörterbücher hinzufügen, die Sie für die Übersetzung verwenden 
möchten. 

Abbildung 5-6 

 

Über die Pfeilsymbole (3) ändern Sie die Reihenfolge der Wörterbücher. Das 
oberste Wörterbuch wird bei der automatischen Übersetzung mit höchster Priorität 
verwendet, das unterste Wörterbuch mit der niedrigsten Priorität. 

Manuell übersetzen 

Um Projekttexte manuell zu übersetzen, klicken Sie auf das entsprechende Feld 
und geben Sie den Begriff ein (1). Mit der unten markierten Schaltfläche (2)  
können Sie die Projekttexte übernehmen, die in beiden Sprachen identisch sind. 

Übersetzung durch externen Dienstleister 

Wenn Sie nicht übersetzte Projekttexte durch einen externen Dienstleister 
übersetzen lassen möchten, folgen Sie der Anleitung im Kapitel 6.5. 
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Automatisch übersetzen 

Um Projekttexte mit Ihren hinterlegten Wörterbüchern zu übersetzen, klicken Sie 
auf die symbolische Schaltfläche "Einträge übersetzen". 

Abbildung 5-7 

 

Die Projekttexte werden automatisch mit den zuvor hinzugefügten Wörterbüchern 
übersetzt. Im Anschluss können Sie die Projekttexte analysieren. Im Dialogfenster 
sehen Sie, wie viele Einträge automatisch übersetzt wurden und wie viele noch 
nicht übersetzt sind. 
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5.8 Projekttexte analysieren 

1. Klicken Sie auf die markierte symbolische Schaltfläche (1). 

Abbildung 5-8 

 
 

2. Das Tool analysiert nun die Projekttexte und gibt anschließend die 
Informationen in folgendem Fenster aus: 

Abbildung 5-9 

 

Sie sehen auf einem Blick die Anzahl der Projekttexte und wie viele davon 
übersetzt bzw. nicht übersetzt sind. Über die Statusleiste (rot markiert) können 
Sie die jeweiligen Projekttexte in den folgenden Kategorien anschauen und 
editieren: 

 

Tabelle 5-1 

Spalte Anzeige 

Nicht übersetzt 
("Not translated") 

Hier werden alle Projekttexte angezeigt, die auf Basis der 
vorhandenen Wörterbücher nicht übersetzt wurden. 
 

Referenzduplikate 
("Reference duplicates") 

Mit Hilfe dieses Filters finden Sie Texte die sich in der  
Ausgangssprache unterscheiden, in der Zielsprache aber mit 
identischen Begriffen übersetzt sind. 

 

Übersetzungsduplikate 
("Translation duplicates") 

Mit Hilfe dieses Filters finden Sie Texte die in der  
Ausgangssprache identisch sind, in der Zielsprache aber mit 
verschiedenen Begriffen übersetzt sind. 

1 
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Spalte Anzeige 

Ungeprüfte Übersetzungen 
("Unverified translations") 

In den Wörterbüchern können Sie Übersetzungen überprüfen. 
Wenn das Tool aus ungeprüften Einträgen übersetzt, werden 
die entsprechenden Projekttexte hier aufgelistet. 

 

Mehrfache Übersetzungen 
("Multiple Translations") 

Ist für ein Referenzbegriff (Quellsprache) mehr als eine 
Übersetzung im Wörterbuch verfügbar, können Sie hier 
auswählen, welche Übersetzung Sie für die Texte verwenden 
möchten. 

Längenunterschiede 
("Length differences") 

Hier werden Übersetzungspaare angezeigt, deren 
Buchstabenlänge um mehr als 10 % voneinander abweicht. 
Wenn der Längenunterschied zu groß ist, können bei der 
HMI-Visualisierung Anzeigefehler auftreten. 

 

 

Bei den "nicht übersetzten" Begriffen haben Sie folgende Möglichkeiten diese 
zu übersetzen: 

1. Übersetzung manuell direkt in diesem Fenster. 
Klicken Sie dazu in der Zeile des Begriffs auf die Zielsprache und geben 
Sie den übersetzten Begriff ein. Bei nicht übersetzbaren Begriffen, z. B. 
Einheiten, nutzen Sie die Schaltfläche mit dem Pfeil zwischen Quell- und 
Zielsprache, um den Begriff in die Zielsprache zu kopieren. 

2. Übersetzung im Wörterbuch. 
Sie können die Wörter direkt in einem Wörterbuch übersetzen und 
anschließend die Schaltfläche "Einträge übersetzen" klicken.  

Die neuen Übersetzungen sollten unbedingt in einem Wörterbuch gespeichert 
werden. Dadurch ist sichergestellt, dass Sie jeden neuen Begriff nur einmal 
übersetzen müssen, da er anschließend automatisch übersetzt wird.  

   

5.9 Projekttexte aus dem TIA Translation Tool exportieren 

Wenn Sie die Texte übersetzt haben, müssen Sie die Projekttexte aus dem TIA 
Translation Tool exportieren und anschließend zurück ins TIA Portal laden. 

1. Klicken Sie dazu auf die markierte Schaltfläche "Projekt exportieren" 

Abbildung 5-10 

 

Wählen Sie im Dialogfenster "Projekt exportieren" ("Export project") ein 
Zielverzeichnis (1), die Referenzsprache des TIA Portal-Projekts (2)  und die 
Sprachen aus, die Sie exportieren möchten (3). 
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Abbildung 5-11 

 

2. Klicken Sie auf die Schaltfläche "OK" (4). 

 

5.10 Import der übersetzten Projekttexte in das TIA Portal 

1. Öffnen Sie Ihr TIA Portal-Projekt. 

2. Klicken Sie auf "Werkzeuge > Projekttexte importieren" ("Tools > Import project 
texts"). 

Abbildung 5-12 

 

Wählen Sie Ihre aus Kapitel 5.9 übersetzten Projekttexte aus. 

3. Wenn Sie Quellsprache noch nicht importiert wurde, aktivieren Sie das 
Optionskästchen "Quellsprachen importieren" ("Import source language") und 
klicken Sie auf die Schaltfläche "Import" 

Abbildung 5-13 

 

Der Übersetzungsprozess ist abgeschlossen.  



6 Wörterbücher 

 

TIA Translation Tool V2 
Beitrags-ID: 109475709,    V1.0,    03/2017   19 
 


 S

ie
m

e
n

s
 A

G
 2

0
1

7
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

6 Wörterbücher 
Mit den Wörterbüchern kann das TIA Translation Tool Ihre Projekttexte in die 
gewünschte Zielsprache übersetzen. Je umfangreicher und besser strukturiert die 
Wörterbücher sind, desto effizienter können Sie Ihre Projekttexte mit dem TIA 
Translation Tool übersetzen.  

Aufbau der Wörterbücher 

Die Wörterbücher können Übersetzungen in mehreren Sprachen beinhalten. Wenn 
ein Wörterbuch Wörter und Begriffe in englischer, deutscher und spanischer 
Sprache enthält, kann damit von jeder enthaltenen Sprache in eine beliebig andere 
enthaltene Sprache übersetzt werden. 

 

6.1 Wörterbuch Global 

Das Wörterbuch Global ist projektübergreifend und steht Ihnen damit im TIA 
Translation Tool für jede Übersetzung zur Verfügung. Benutzen Sie dieses 
Wörterbuch für allgemeine, projektübergreifende Begriffe, die in vielen Ihrer 
Projekte enthalten sind. 

 

6.2 Wörterbücher erstellen und laden 

1. Klicken Sie auf "Datei > Neu > Wörterbuch" ("File > New > Dictionary"), um ein 
neues Wörterbuch zu erstellen. 

2. Geben Sie anschließend im Speicherdialog einen Dateinamen ein und klicken 
Sie auf "Speichern". Wörterbücher werden mit der Dateiendung ".ttdictionary" 
gespeichert. 

3. Um ein bestehendes Wörterbuch zu laden, klicken Sie auf "Datei > Öffnen > 
Wörterbuch > Datei" ("File > Open > Dictionary > File"). Alternativ können Sie 
das globale Wörterbuch laden. 
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6.3 Wörterbücher bearbeiten 

Um Wörterbücher zu bearbeiten, gehen Sie wie folgt vor: 

Klicken Sie auf die Taskcard "Wörterbuch" ("Dictionaries") auf der linken Seite. 

Abbildung 6-1 

 

 

Folgendes integriertes Fenster öffnet sich im Translation Tool: 

Abbildung 6-2 

 

 
 

Schaltflächen zum Schließen des Fensters 
 

Referenzsprache  
 

Zielsprache mit mehreren möglichen Übersetzungen 
 

Sprachauswahl für das Wörterbuch 

 

1 

2 3 

4 

1 

2 

3 

4 
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Um die Wörterbuch Einträge manuell zu bearbeiten, gehen Sie wie folgt vor: 

1. Klicken Sie auf den zu bearbeitenden Begriff in der Spalte "Referenzsprache". 

2. In der Spalte "Zielsprache" sehen Sie alle bisher gespeicherten Übersetzungen 
für diesen Eintrag. 

3. Klicken Sie auf die Übersetzung, um diese zu bearbeiten. Durch einen Klick 
auf die leere Zeile fügen Sie eine weitere Übersetzung für diesen Begriff ein.  

4. Aktivieren Sie das Optionskästchen. Damit erhält diese Übersetzung den 
Status "geprüft". 

 

 

6.4 Wörterbücher erweitern 

Um den automatischen Übersetzungsgrad des Tools zu erhöhen, müssen Sie die 
Wörterbücher aktuell halten und ständig erweitern. Dazu speichern Sie die 
Einträge, die bisher nicht automatisch durch das Tool übersetzt werden konnten, in 
ein Wörterbuch. 

Übersetzungen in ein Wörterbuch übernehmen 

Sie haben neue Begriffe übersetzt und wollen diese nun in ein Wörterbuch 
übernehmen. 

1. Klicken Sie auf die Schaltfläche "Kopiere ins Wörterbuch" ("Copy to dictionary") 

2. Es öffnet sich der Dialog "Kopiere ins Wörterbuch" ("Copy to dictionary"). 

Abbildung 6-3 
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3. Wählen Sie über die Klappliste ein Wörterbuch aus (2). 

Hinweis Es können nur Wörterbücher ausgewählt werden, die Sie in der Taskcard 
"Einstellungen" ("Settings") im Vorfeld hinterlegt haben 

Über die Reiter können folgende Kategorien auswählen (3). 

– Alles ("All") 

– Übersetzt ("Translated") 

– Unübersetzt ("Untranslated") 

– Verschiedene Übersetzung ("Different Translation") 

– Mehrfache Übersetzung ("Multiple Translation") 

4. Um die entsprechenden Begriffe in das ausgewählte Wörterbuch zu kopieren, 
klicken Sie auf die Schaltfläche "OK". 

 

 

6.5 Wörterbücher importieren und exportieren 

Wenn Sie die nicht übersetzten Projekttexte von einem externen Dienstleister 
übersetzen lassen möchten, gehen Sie wie folgt vor: 

1. Speichern Sie alle nicht übersetzten Projekttexte in einem Wörterbuch ab. 

2. Exportieren Sie das Wörterbuch im Excel-Dateiformat. 

3. Der externe Dienstleister übersetzt die Projekttexte in dieser Excel-Datei. 

4. Importieren Sie die fertig übersetzte Excel-Datei.  

5. Importieren Sie das Wörterbuch in das TIA Translation Tool 

6. Übersetzen Sie die Projekttexte im TIA Translation Tool, indem Sie auf die 
Schaltfläche "Einträge übersetzen" klicken. 
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7 Anhang 

7.1 Service und Support  

Industry Online Support 

Sie haben Fragen oder brauchen Unterstützung?  

Über den Industry Online Support greifen Sie rund um die Uhr auf das gesamte 
Service und Support Know-how sowie auf unsere Dienstleistungen zu.  

Der Industry Online Support ist die zentrale Adresse für Informationen zu unseren 
Produkten, Lösungen und Services.  

Produktinformationen, Handbücher, Downloads, FAQs und Anwendungsbeispiele 
– alle Informationen sind mit wenigen Mausklicks erreichbar:  
https://support.industry.siemens.com 

Technical Support 

Der Technical Support von Siemens Industry unterstützt Sie schnell und kompetent 
bei allen technischen Anfragen mit einer Vielzahl maßgeschneiderter Angebote 
– von der Basisunterstützung bis hin zu individuellen Supportverträgen. 

Anfragen an den Technical Support stellen Sie per Web-Formular:  
www.siemens.de/industry/supportrequest 

Serviceangebot 

Unser Serviceangebot umfasst, unter anderem, folgende Services:  

 Produkttrainings 

 Plant Data Services 

 Ersatzteilservices 

 Reparaturservices  

 Vor-Ort und Instandhaltungsservices 

 Retrofit- und Modernisierungsservices 

 Serviceprogramme und Verträge  

Ausführliche Informationen zu unserem Serviceangebot finden Sie im 
Servicekatalog: 
https://support.industry.siemens.com/cs/sc 

Industry Online Support App 

Mit der App "Siemens Industry Online Support" erhalten Sie auch unterwegs die 
optimale Unterstützung. Die App ist für Apple iOS, Android und Windows Phone 
verfügbar: 
https://support.industry.siemens.com/cs/ww/de/sc/2067 

 

 

https://support.industry.siemens.com/
http://www.siemens.de/industry/supportrequest
https://support.industry.siemens.com/cs/sc
https://support.industry.siemens.com/cs/ww/de/sc/2067
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7.2 Links und Literatur  

Tabelle 7-1 

Nr. Thema 

\1\ Siemens Industry Online Support 

https://support.industry.siemens.com 

\2\ Link auf die Beitragsseite des Anwendungsbeispiels  

https://support.industry.siemens.com/cs/ww/de/view/109475709 

\3\  

 

 

7.3 Änderungsdokumentation 

Tabelle 7-2 

Version Datum Änderung 

V1.0 03/2017  Erste Ausgabe 

   

 

 

 

https://support.industry.siemens.com/
https://support.industry.siemens.com/cs/ww/de/view/109475709
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